OfficeServ
SP Driver Description

Ed. 00
9. 2003.



COPYRIGHT

This manual is proprietary to SAMSUNG Electronics Co., Ltd. and is protected by copyright.

No information contained herein may be copied, translated, transcribed or duplicated for any
commercial purposes or disclosed to third parties in any form without the prior written consent of
SAMSUNG Electronics Co., Ltd.

TRADEMARKS

Product names mentioned in this document may be trademarks and/or registered trademarks of
their respective companies.

This manual should be read before the installation and operation, and the operator should correctly install
and operate the product by using this manual.

This manual may be changed for the system improvement, standardization and other technical reasons without prior
notice.

For further information on the updated manual or have a question the content of manual, contact Document Center at
the address below .

Address : Document Center 2nd Floor IT Center. Dong-Suwon P.O. Box 105, 416, Metan-3dong Paldal-gu,
Suwon-si, Gyeonggi-do, Korea 442-600

e-mail : manual@samsung.com

Or contact Call Center at the telephone below if you have any questions or concerns regarding the operation of your
system.

Phone : 81-1588-4141

http://iwww.samsungnetwork.com

©2003 SAMSUNG Electronics Co., Ltd. All rights reserved.



INTRODUCTION

Purpose

The OpenTSP Driver Manual provides a brief description on the OpenTSP, the
installation procedure, and the procedure on using the functions of the OpenTSP, for
engineers who develop the TAPI service and telephony application programs.

Document Content and Organization

This manual includes six chapters and the ‘Acronyms’. The chapters are summarized
as follows :

CHAPTER 1. Introduction

This chapter provides description on the TAPI, used on the TSP driver before using
the OpenTSP, the list of supported functions, and the list of functions used only on
the TSP driver.

CHAPTER 2. OpenTSP Driver Installation

This chapter describes items that must be checked before installing the OpenTSP
driver and the procedure for installing the OpenTSP driver.

CHAPTER 3. OpenTSP Window Description

This chapter provides description on the screen, toolbar, and buttons of the various
tools created after the installing the OpenTSP driver.

CHAPTER 4. OpenTSP Driver Guide

This chapter provides the procedure on dialing, receiving, and disconnecting calls
through the OpenTSP driver.

CHAPTER 5. TAPI Functions

This chapter describes the TAPI functions and expansion functions supported by the
OpenTSP driver.
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CHAPTER 6. Call Processing Flow

This chapter describes the life cycle of the TAPI, various call processing events of the
OpenTSP driver, and the call processing procedure.

ABBREVIATION

The frequently used acronyms and their meanings in this guide are all collected.

Conventions

The following special paragraphs are used in this document to point out information
that must be read. This information may be set-off from the surrounding text, but is
always preceded by a bold title in capital letters.

>

WARNING

WARNING

Indicates a potentially hazardous situation which if not avoided, could result in death
Or Serious injury.

>

CAUTION

CAUTION

Indicates a potentially hazardous situation which if not avoided, may result in minor or
moderate injury. It may also be used to alert against unsafe practices.

CHECK

CHECKPOINT

Provides the operator with checkpoints for stable system operation.

Z|§§§|
C)I
m

NOTE

Indicates additional information as a reference.

e

OPERATION PROCEDURES

Indicates the operation procedures that should be executed in order.

Page Il
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Console Screen Output

e The lined box with ‘Courier New’ font will be used to distinguish between
the main content and console output screen text.

e ‘Bold Courier New’ fontwill indicate the value entered by the operator on
the console screen

References

OfficeServ Operator Manual

The OfficeServ Operator Manual describes the main features, installation procedure,
service settings, and user guide of the OfficeServ Operator, an application program
for telephony communication.

OfficeServ Call Manual

The OfficeServ Call Manual main features, installation procedure, service settings,
and user guide of the OfficeServ Call, an application program for telephony
communication.

Revision History

Edition No. Date of Issue Remark

00 9. 2003. Original
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CHAPTER 1
Introduction

1 Introduction to OpenTSP

The OpenTSP Telephony Service Provider Driver 3.x(referred to as ‘OpenTSP’
hereinafter) interfaces with the Samsung key telephone switch through the TCP/IP
system, based on TAPI 2.x/TAPI 3.x, and enables call control and call processing of
the Telephony Application Programming Interface(TAPI) service through the TSPI.
The OpenTSP driver is installed on a PC using the Windows O/S. The TAPI 2.x/TAPI
3.x was designed by Microsoft based on the TAPI standard.

The Microsoft TAPI consists of the three modules shown below :

Window based PC

Telephony
Application

| TAPI

TAPI
Service

| TSPI

Telephony
Service
Provider

Phone System
(PBX, Key Telephone
System etc.)

v

Figure 1.1  TAPI Configuration Diagram
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Modules in Figure 1.1 are described below :

Telephony Application

Supplied by the application vender, the Telephony Application provides features such
as call processing to the users through the TAPI, an API provided by the Microsoft
TAPI Service.

Telephony applications include the “‘dialing’ program, basically embedded in the
Windows OS, and the Outlook, the Contact Manager program of Microsoft.

TAPI Service

As a basic module of the Microsoft Windows OS, the TAPI Service directly uses the
Telephony Service Provider installed on a PC upon the request of the application
program.

Telephony Service Provider (TSP)

Provided by the switch vendor, the TSP is a service provider that communicates with
the Microsoft TAPI. The TSP is executed when the application program requests the
TAPI feature.

OpenTSP Features

Since the OpenTSP driver is a TSP composing the TAPI of the Windows OS, the
Telephony Application program connects to the TAPI Service through a CTI to use
the features of the Samsung key telephone system.

OpenTSP references the specification of the Microsoft TAPI, which supports the
features introduced in *5.2. TAPI Function.’

Following features that are supplied only by the OpenTSP driver are described in 3.
OpenTSP Driver Extended Function Feature List’.

e Station Lock

*  Vacant Station Message

* Follow me

*  Make new trunk call

* Page

e System hold retrieval

*  Clear Message Waiting

*  Clear Call back

* OHVA

e Silent Monitoring

e Mute on/off

* Line Reset Function

© SAMSUNG Electronics Co., Ltd.



CHAPTER 2
OpenTSP Driver Installation

This chapter describes the environment and procedure required for the installation of
the OpenTSP driver. For proper installation and operation of the OpenTSP driver, the
installation environment and conditions should be checked before installation.

Refer to the table below, in which the installation procedure is summarized, when
installing the OpenTSP driver.

Table 2.1 OpenTSP Driver Installation Procedure

Step Procedure Description

1 Installation Environment and | Check the following environment and condition before

Conditions installing the OpenTSP driver.

- Check the H/W and S/W environments.

- Check for the OpenTSP driver license key.

- Check if the OfficeServ Link program has been installed.

- Previous versions of Samsung TAPI drivers should not be
on the system.

2 OpenTSP Driver Installation | Install the OpenTSP driver according to the installation
Procedure procedure.

Read the Cautions and Notes carefully to prevent error
during installation.

3 Installation Data Verification After installing the OpenTSP driver, check if the installation is
successful by verifying the driver file and the registration

status.

© SAMSUNG Electronics Co., Ltd. Page 2-1
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1 Installation Environment and Conditions
The OpenTSP driver may be installed and executed for call processing on various Os
of the Microsoft Windows. This section describes the environment and conditions

that are required for proper installation of the OpenTSP driver.

1.1 Installation Environment

Check the installation environment below before installing the OpenTSP driver.

Table 2.2 OpenTSP Driver Installation Environment

Type Category Requirement

Hardware | Compatible Switch The OpenTSP may only be used in the Samsung key telephone
system, which supports the TAPI 2.x interface.

Switch Interface The OpenTSP may only use the switch service through a
separate S/W called OfficeServ Link.

Network Interface A network card supporting TCP/IP protocol should be installed
on the PC.
Software | TAPI version TAPI 2.x or higher
0os - Windows 98 : Since the TAPI 2.x is included in the Second

Edition of Windows 98, only the Windows 98SE version can
be used.

- Windows ME : Check the TAPI version and upgrade through
the Service Pack if the version is lower than 2.x.

- Windows 2000, Windows XP : Basically includes the TAPI 3.x.

- Windows NT : The TAPI 2.x is included in 4.0 or higher
versions of the Service Pack. Check the service pack version
and upgrade the service pack version to 4.0 or higher.

- Windows CE : Does not support Windows CE.

Page 2-2 © SAMSUNG Electronics Co., Ltd.
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1.2 Installation Conditions

Check the items below before installing the OpenTSP driver on the system.

Valid License

The license key is required for installing and using the OpenTSP driver.

OfficeServ Link Program

The OfficeServ Link program should be installed to use the CTI features on the
Samsung key telephone system. All CTI application programs are connected to the
switch through the OfficeServ Link program.

OfficeServ Link Program

The OfficeServ Link program is a software that enables multiple CTI application
NOTE  programs to connect to the switch, and controls the message flow between the

application programs and the switch. Refer to the OfficeServ Link Manual for details

such as installation and operation of the OfficeServ Link program.

Samsung TSP Driver

Delete previous versions of the Samsung TSP driver, if any, before installing the new
driver.

Previous versions of the Samsung TSP driver may be installed in cases below :

* If the Samsung TAPI2.x was installed on a PC using the Windows NT or 2000
Server OS

* If the computer where the Samsung TAPI2.x driver was installed is set as the
Telephony Client

* If the Spot Call or iDCS Call Version 5.1 or lower is installed

© SAMSUNG Electronics Co., Ltd. Page 2-3
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Procedure for checking the information on the TSP driver installed on the computer is
as follows :

1) Select “Start-> Settings—> Control Panel’ on the computer.

% windows Update

Programs L4
@ Diocuments 4

@on

Settings Control Panel

Metwork and Dial-up Connections
@ Search 4
Prinkers

@ Help Taskbar & Start Menu. ..

Rﬁ Rur...

2000 Professional

& Log OFf Administrator, ..

“I Shut Dowr, ..

Figure 2.1 Starting the Control Panel

2) Double click ‘Phone and Modem Options’ from the “Control Panel’ shown below :

B3 Control Panel - |EI|1|
J File Edit Wiew Favorites Tools  Help ﬁ
J #=Fack v~ = - | @Search L7 Folders gHistory | [l O ¢ oy | Ed-
J Address |@ Control Panel j P
= bd = @?? [€]Accessibilty Options
L AddiRemove Hardware [ AyddfFemove Programs
{24
E 3] Administrative Tools @ Date/Time
Control Panel @ Display q‘Folder Oiptions
[a) Fars @ Game Cortrallers
Phone and Modem Dptions i Internet Options & Java Plug-in 1.4.0_03
Configures your telephone dialing rulesﬁkeyboard b Mouse
and modern propetties Mebwark and Dial-up Connections . Phone and Modem Options
windows Update HPower Options Printers
Windows 2000 Suppart @Regional Options %Scanners and Camer as
Scheduled Tasks \E|550unds and Multimedia
(S 3ystem & Users and Passwords
Configures wour telephone dialing rules and modem properties | |@. MMy Compuker 7

Figure 2.2 Selecting Phone and Modem Options
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CHAPTER 2. OpenTSP Driver Installation

3) Select [Edit(E)] from the ‘Phone and Modem Options’ window.

© SAMSUNG Electronics Co., Ltd.

Phone And Modem Dptions: 2x]|

Dialing Rules | Modemsl .&dvancedl

& The lizt below displays the locations you have specified. Select the
& loeation fram which pou are dialing.

Locations:
Location I Area Code I
[O] My Location 02

Mew... Edi... [elete

,TI Cancel Spply

Figure 2.3 Phone and Modem Options Window
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4) Enter the fields of the ‘Edit Location” Window by referring to the figure below
and click the [OK] button.

General I Area Code Rules I Calling Card |

Location name:

Specify the location from which yau will be dialing.

Country./regian: Area code:
I Forea [Republic of] j |D2
— Dialing rules

Wwhen dialing from this location, uge the following miles:

To access an outside line for local calls, dial: IS
To access an outgide line for long-distance calls, dial; IS
™ To disable call waiting, dial | =]

Dialusing. ¢ Tone & Pulze

QK. I Cancel Aol

Figure 2.4 Edit Location Window

Select ‘Country/Region’ and enter your area code. Do not enter “0’ of the area code.
For example, if the area code is 031, enter “31°.
The ‘Dialing Rules’ option is used for making external calls through the TAPI. Enter

the number to be used for making external calls. The number assigned for outside
calls is usually “9’.

Dialing Rules

Since phones in offices usually connect to the trunk line through a private switch,
NOTE consult the telephony manager of your company for information on the number

assigned for outside calls.
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5) Select the ‘Advanced’ tab from the ‘Phone and Modem Options’ screen to
display the list of drivers(telephony service providers) installed on the system.

Phone And Modem Dptions d

Dialing Hulesl Modems  Advanced |

@ The fallowing telephony providers are installed on this computer:

Providers:

Microsoft H.323 TAP| Service Provider

Microsoft Multicazt Conference TAP! Service Provider
MOIS Prosy TAPI Service Provider

TAPI KernelMode Service Provider

Unimodem 5 Service Provider

Add... | Femove | Configure...l

ak I Cancel | Apoply |

Figure 2.5 Advanced Tab of Phone and Modem Options

The TAPI compatible driver can be installed separately on each computer, and a
newly added TAPI driver is displayed on the ‘Advanced’ tab of the ‘Phone and
Modem Options’.

The TAPI driver is registered as ‘Samsung SCTSP32 TAPI2.x Compatible Telephony
Service Provider’ or ‘Samsung DCSTSP Telephony Service Provider’.
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1.3 Checking the Telephony Service

The procedure for checking if the Telephony service is normally operating is as
follows :

1) Select “Start-> Settings—> Control Panel’ from the computer.

% Windows Update
Programs 4

@

Documents L4

Cankral Panel

$HY  Settings

=

Metwork and Dial-up Connections
Search 4 ]

Brinkers
Help ﬂ Taskbar & Stark Menu, ..
Run...

Log OFf Administratar. ..

ndows 2000 Professional

AR AN

Shut Down. .

Figure 2.6 Executing the Control Panel

2) Double click the ‘Administrative Tools’ from the control panel below.

T e — =lo(xI

JFi\e Edit  Wew Favorites Tools Help ﬁ

J d=Fack ~ = - ‘ @search [ Folders £ #History ||¥ X =5 | [E-

JAddress I@ Control Panel j e
- {5 e | @?? Accessibi\ity Options %AddIRemove Hardware
| | Add,l’Remove Programs Administr: ools @Dataﬂlme
E Display ﬁFnldEr Options 4] Fonts
Control Panel @Game Controllers @Intemet (Options @Java Flug-in 1.4.0_03
%Keyboard {) Mouse MNetwork and Dial-up Connections
Administrative Tools Phone and Madem Options ﬁPDwar Options Printers
Configures administrative settings for @Regional Options &Scannars and Cameras (@] Scheduled Tasks
vour computer 4 Sourds and Multimedia {0 System s lisers and Passwards

‘Windows Update
‘Windows 2000 Support

|Configures administrative settings For your computer | |@ My Computer )

Figure 2.7 Selecting Administrative Tools
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3) Select ‘Service’ from the ‘Administrative Tools’ window.

I =
J File Edit ‘iew Favorites Tools Help ﬁ
J = Back - = - | Pzearcn  [yFolders  CHHistory | 503 X @ | -

J Address I Administrative Tools j @Gu

el = « [ Component Services
L@ L 7] Event: Viewer
e i Performance
Administrative =
Tools
Services
shartcut

Starts and stop services.

Modified: 1996-03-18 25 3141

Cnmputer Managerment
ﬂlntemet Services Manager
@Parsnna\ ‘Web Manager
aﬂTaInet Server Administration

@Data Sources (ODBC)
@ Local Security Policy
Eﬂ Server Extensions Administrabor

‘Starts and stop services,

EE

|E.EJ. My Computer &

Figure 2.8 Selecting Service

4) Check the ‘“Telephony’ service(TAPI service) status from the ‘Service’” window
below. If the “Telephony’ service is displayed as ‘started’, as shown below, the

TAPI service is operating.

Services 3] x|
| action yiew|J<--b| o | B |@|J>lll n |
Tree I Mame # | Descripkion | Stakus | Startup Type | Log ©n As | ;I

% Services (Local) %Security Accounts ... Stores sec,,.  Started Autamatic LocalSystem
%Server Provides R...  Started Aukamatic LocalSystem

%Simple Mail Transpa...  Transports,.,  Started Automatic LocalSystem

%Smart Card Manages a... Manual LocalSystem

%Smart Card Helper Provides s... Manual LocalSystem

%System Event Motifi... Tracks syst.., Started Automatic LocalSystem

%Task Scheduler Enables a ...  Started Automatic LocalSystem

%TCPIIP MetBIOS Hel,., Enables su,..  Starte Automatic LocalSystem

2 EE]

%Telnet Allows are... Manual LocalSystem

%Uninterruptible Pow... Manages a... Manual LocalSystem

%Ut\lity Manager Starts and ... Manual LocalSystem

Windows Installer Installs, re... Manual LocalSystem

%Windows Managem... Providess...  Started Automatic LocalSystem

%Windows Managem... Providess...  Started Manual LocalSystem

%Windows Time Sets the co... Manual LocalSystem

%winFiISZ Started Automatic LocalSystem

%WINS Client Maintains a... Started Automatic LocalSystem

%Workstation Provides n...  Started Automatic LocalSystem

%World ‘Wide Web Pu... Provides W... Started Automatic LocalSystem

-
Figure 2.9 Service Window
IS Terminating/Restarting the Telephony Service
Iy . . .
‘{/ Users can terminate or restart the telephony service, if necessary, through the above
NOTE window.

© SAMSUNG Electronics Co., Ltd.

Page 2-9




CHAPTER 2. OpenTSP Driver Installation OfficeServ OpenTSP Driver Description/Ed.00

5) The telephony service of the Windows OS is related to the following services.
Thus, the services below should be checked for normal operation.

* Remote Access Auto Connection Manager

* Remote Access Connection Manager

Services o ] 4]

| acton wew ||+ o [@@EFRB| 2] > = 0 » |
Tree I Mame  / | Descripkion | Status | Startup 'I:I
W S Print Spacler Loads files ... Started  Automati
%Protected Storage Provides pr... Started Automati
%QDS RSVP Provides n.., Manual
oo wote Access Auto Connection Manager Creates a ... Manual
%Remote Access Connection Manager Creates a... Manual
%Remote Procedure Call {(RPC) Provides th,., Started Automati
%Remute Procedure Call {RPC) Locator Manages t... Manual
%Remote Reqistry Service Allaws rem...  Started Autarnati
%Removable Storage Managesr...  Started Automnati
%Routing and Remate Access Offers rout... Disabled
RunAs Service Enables st...  Started Aukomati
%Security Accounts Manager Stores sec..,  Started Aukornati
Server Provides R...  Started Automati
%Simple Mail Transport Protocol (SMTR) Transports...  Started Autornati
%Smart Card Manages a... Manual
%Smart Card Helper Provides s... Manual
%System Event Motification Tracks syst,., Started Automnati
%Task Scheduler Enables a ...  Started Aukomati
%TCPIIP NetBIOS Helper Service Enables su...  Started Automnati
Telephony Provides T... ftarted Manual ™
1 3

Figure 2.10 Telephony Service

Cases where the OpenTSP Driver is not Properly Loaded or Unloaded

If the two services above are operated ‘Manually’ the two services will act as a single

CAUTION module of the telephony service. If the two services were abnormally set during the
system setup procedure, the two services and the telephony service may not operate
normally and the OpenTSP driver may not be loaded or unloaded properly, disabling
the use of related application programs. To avoid such incidents, it is recommended
to set the start type as ‘Not Used'’ to disable unnecessary services. If the two services
are marked as ‘Started’ and the OpenTSP does not operate properly, change the
‘start type’ to ‘Not Used’ and reboot the system.
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2 OpenTSP Driver Installation Procedure

The procedure for installing the OpenTSP driver is as follows :

1) Double click the OpenTSP installation file(OpenTSP_V20_Setup.exe) on the
CD-ROM.

L[

2) Click the [Next>] button on the screen below.
x|

DOfficeSery OpenTSP Driver Setup

Wwelcome!ll After now, OfficeSery OpenTSP Driver will be
installed.

< Back I Mext > I Cancel

Figure 2.11 Installation Window

3) Read the License Agreement below and select [Yes] to approve. Select [No] to
abort the installation program.

Installshield Wizard

License Agreement
Please read the following license agreement carefully,

Press the PAGE DOWN key to see the rest of the agreement.

5 oftware License Agreement & Limited W arranty ﬂ
for Samsung T elephany Service Pravider for DCS Keyphone Series.
Samsung Electronics Co., LTD.

IMPORTANT, READ CAREFULLY :

This Samsung End-User License Agreement [ELILA] iz a legal binding agreement between
woul [either an individual or an entity] and Samsung for Samsung software product
identified above, which includes computer software and may include printed material, and j

Do you accept all the terms of the preceding Licensze Agreement? |f you choose Mo, the
setup will cloze. To install OfficeSery OpenTSP Driver, vou must accept this agreement.

IristallShield

< Back Tes Mo

Figure 2.12 License Agreement
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4) The ‘Choose Destination Location’ window appears as shown below. Click the
[Next>] button to use the default path(C:\Program Files\Samsung Telephony
Service Provider) or click the [Browse] button to change the installation folder.

Installshield wizard x|

Choose Destination Location

Select folder where Setup will install files. =

&

Setup will inztall DffizeSery OpenTSP Driver in the follawing folder.

Ta inztall to this folder, click Mext. To install to a different folder, click Browse and select
anather folder.

" Destination Folder

D:h ADfficeSery OpenTSP Driver Browwse... |

| mstallShield
< Back | Mext > I Cancel |
Figure 2.13 Selecting Installation Folder
OpenTSP Driver Installation Folder
@ The OpenTSP installation program installs two types of programs on the user’s

NOTE computer.
The SCTSP32.TSP file(basic Telephony Service Provider file) is copied to the
C:\WINNT\system32 folder and is registered to TAPI .
Utility programs required for installing and operating the OpenTSP driver are copied
to the C:\Program Files\Samsung Telephony Service Provider folder.
Thus, the folder selected during the installation procedure above(C:\Program
Files\Samsung Telephony Service Provider) is the location to where the utility
programs are copied.
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5) Select “Typical’ from the ‘Setup Type’ window below and click the [Next>] button.

InstallsShield Wizard

Setup Type
Select the Setup Type ta install

Click the type of Setup you prefer, then click Mest.

& Typical Program will be installed with the most common options. Recommended for
miogh uzers.,

" Compact  Program will be installed with minimum required options.

™ Custam r'ou may choosze the optionz you want to ingtall Recommended for advanced
Lgers.

InstallShield

< Back Mewt > Cancel

Figure 2.14 Selecting Installation Type
6) The ‘Select Program Folder’ window below appears. Click the [Next>] button to

use the default name(Samsung Telephony Service Provider). Enter a new name
into the field to change the folder name.

Installshield Wizard

Select Program Folder

Pleaze zelect a program folder.

Setup will add program iconz to the Program Folder listed below. 'ou may type a new folder
name, or select one from the existing folders list. Click Mext to continue.

Program Folders:

Exigting Folders:

Accessones -
Administrative Tools J
Java 2 Runtime Enviranment

Microsoft Office ?7

Frinttde Internat Printing

Shaglt &

SpotMews 2.2

Startup

univlE'w'3

IrstallShield

< Back | Mext > I Cancel

Figure 2.15 Selecting Installation Folder
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7) Enter the entry items of the ‘Phone and Modem Options’ window below.
Dialing Rules |

@‘} The list below displays the locations you have specified. Select the
e location from which you are dialing.

Locations:
Location | Area Code I
(Gl My Location 02

Mew... Edit... Delete

Phone number will be dialed as

Ok, I Cancel Apply

Figure 2.16 Phone and Modem Options

T ‘Dialing Rules’ Setup
.;'é’/y Refer to the steps from 1) to 4) of the ‘Samsung TAPI Driver” in ‘1.2 Installation
Conditions’ for setting the ‘Dialing Rules’.
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8) Enter the items of the *Communication Parameters’ window below and click the
[OK] button.

Communication Parameters 5[

— Connect to Server [ OfficeSery Link |

Server IP Address : I 1.1.1.1
Server Port Mo I G000
— Trace Type

" None i Levell 0 Lewvel 2

(] | | Cancel | | About

Figure 2.17 Communication Parameters

y Trace Type
N
//7 The Trace Type setup affects the performance of the OpenTSP driver and should be

NOTE set to ‘None’ under normal circumstances. Change the setting to ‘Level 1’ or ‘Level 2’
only when searching specific statuses.

) If the OpenTSP is installed when OfficeServ Link is not operating
'Z] Though the OpenTSP driver can be installed while the OfficeServ Link is not

NOTE operating, the CTI application program automatically attempts connection to the
corresponding port after the installation. Thus, the ‘Communication Parameter’ should
be set to enable connection to the OfficeServ link before starting the CTI application
program.
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9) Upon successful installation of the OpenTSP driver, the ‘OpenTSP Setup
Complete” window appears. Click the [Finish] button.

InstallShield Wizard

OfficeSery OpenTSP Setup Complete

The InstallShield wizard has successfully installed OfficeSery
OpenTSP Driver. Click Finish to exit the wizard.

< Back | Firish I Cancel

Figure 2.18 Installation Complete

Page 2-16 © SAMSUNG Electronics Co., Ltd.



OfficeServ OpenTSP Driver Description/Ed.00 CHAPTER 2. OpenTSP Diriver Installation

3 Checking Installation Data
3.1 Checking the OpenTSP Driver Files

During the installation of the OpenTSP driver, the OpenTSP driver and utilities
should have been copied to the folders below :

Location of the OpenTSP driver file

The OpenTSP driver is copied to different folders depending on the OS.

*  Windows NT/Windows 2000 : Winnt\System32\sctsp32.tsp
*  Windows XP : Windows\system32\sctsp32.tsp
e Windows 98/Me : windows\system\sctsp32.tsp

Location of the OpenTSP driver utility files
The OpenTSP utility files should have been copied to the folder below if the default
location in ‘Figure 2.15 Selecting Installation Folder” was not changed.

*  Program Files\Samsung Electronics\Samsung Telephony Service Provider

Utilities for OpenTSP driver

The utilities required for installing/operating the OpenTSP driver are as follows :

e TB20.exe : Program for testing TAPI 2.x features

* DBGView.exe : Trace Message Viewer program

»  Scavenger.exe : Program for removing Mismatch Call Handle

* TAPISampler.exe : Test program for simple dialing/receiving/disconnecting calls
and for tracking call status/data

e OpenTSP Config Tool : Communication environment setup program for
OpenTSP driver
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As shown below, the utility programs are located at ‘Start-=>Programs—>Samsung
Telephony Service Provider’ for convenient use.

AL U e e g

B Acrobat Distiler 6.0
“% Windows Update

m Adobe Acrobat 6.0 Professional

ery OpenTSP Driver

[ & Messane viewer

¥ = OpenTSP Config Tool

Programs

& Scavenger Tool
E Tapi Browser Tool

f‘ Tapi Sampler Tool

Documents r

Setkings L4

Search >

Help

2000 Professional

&% MOENED

Run...

Log OFf Administrator. ..

Shut Dawn...

Figure 2.19 OpenTSP Utility Program

3.2 Checking the OpenTSP Driver Registration

The registration of the OpenTSP driver file, which is registered as the TAPI driver of
the Microsoft Windows OS, can be verified as follows. :

Check for the ‘Samsung SCTSP32 TAPI2.x Compatible Telephony Service Provider’
on the ‘Advanced’ tab of the ‘Start->Control Panel->Phone and Modem Options’.

Phone And Modem Options 2=l

Dialing Rules I Modems  Advanced |
;@ The following telephony providers are installed on this computer:

Providers:

Microzoft H.323 TAPI Service Provider
Microzoft Multicast Conference TAPI Service Provider
MOIS Prasy TAP| Service Pravider

Samsung OfficeSery OpenT SP Driver for Keyphane
TAP! KemelMode Service Provider
Unimadem 5 Service Provider

Add... | Femove | Eonfigure...l

ok I Cancel | Lpply |

Figure 2.20 Advanced Tab of Phone and Modem Options
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3.3 Changing the OpenTSP Driver Environment Settings

The user may change the environment settings of the OpenTSP driver. The driver
environment can be changed either through the ‘Phone and Modem Options’ screen

or through the OpenTSP Config Tool program.

Changing from the ‘Phone and Modem Options’ screen

e

Phone And Modem Options

Dialing Hulesl Modems Advanced |

@ The following telephony providers are installed ot this computer:

Providers:

2]

TaP! Kemel-tode Service Provider
Unimodemn & Service Provider

Microzoft H.323 TAFI Service Provider
icrozoft Multicast Conference TAP Service Provider
MDI5 Prowy TAP| Service Provider

Samsung Offic v OpenT SP Driver for Keyphone Series

Femove | I:c-nfigure...l

1) Click the [Configure] button from the *Start->Control Panel->Phone and
Modem Options—>Advanced’ screen.

Cancel |

Apply

Figure 2.21 Selecting Configure

© SAMSUNG Electronics Co., Ltd.
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2) On the OpenTSP environment configuration screen below, change the settings
and click the [OK] button.

Communication Parameters 5[

— Connect to Server [ OfficeSery Link |

Server P Address I 165.213.80.88
Server Port Mo I G000
— Trace Tupe

i Mone  Levell 0 Level 2

Qg | | Cancel | | About

Figure 2.22 Communication Parameters

3) The message below appears to confirm the changes.

Samsung SCTSP32 for DCS Keyphone Series. ﬂ

@ You need to close and restart all TAPT applications for changes ko kake effect.

Figure 2.23 Confirming Changes in Environment Settings

4) The OpenTSP driver must be restarted to apply the changes. Thus, close all CTI
application programs and restart the OpenTSP driver.
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Using the OpenTSP Config Tool program

The OpenTSP Config Tool program, which allows the user to change the
configuration of the OpenTSP driver, is installed in the OpenTSP driver installation

folder. Through this program, users can easily check and change the settings.

The procedure for changing the OpenTSP driver environment through the OpenTSP
Config Tool program is as follows :

L[

OfficeSery OpenTSP Driver

Before changing each configuration value, you have to stop all tapi applications at First,

1) Execute the ‘OpenTSP Config Tool’ under the “Start->Programs—> Samsung
Telephony Service Provider’. The screen below is displayed.

Figure 2.24 Closing TAPI Compatible Program

2) The message above informs the user that all TAPI compatible programs need to
be closed before changing the environment settings. Close all TAPI compatible
programs that are currently operating and click the [OK] button.

3) Enter the fields in the window shown below and click the [OK] button.

== 0penTSP Configuration Tool ﬂ

— Connect to Server [ OfficeSery Link ]
Server IP Address | 165.213.88.88
Server PortMo: | 6000
— Trace Type
{* Mone  Lewvel 1 = Level 2

0k

Figure 2.25 OpenTSP ConfigTool

¢

NOTE

OpenTSP Configuration Tool

Refer to item 9) of the ‘2 OpenTSP Driver Installation Procedure’ for detail
descriptions on each field.

© SAMSUNG Electronics Co., Ltd.
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4 Removing the OpenTSP Driver

Remove the OpenTSP driver installed on the system when the driver is no longer
needed or when removing a previous version to install a new version of the driver.

Closing all TAPI compatible programs

All TAPI compatible application programs that are currently running must be closed

caution  before removing the OpenTSP driver. If the OpenTSP driver is being operated by a
TAPI compatible application program, error may occur during the uninstallation
process.

The procedure for removing the OpenTSP driver is as follows :

1) Select *Start->Settings—>Control Panel->Add/Delete Program’ to display the
screen below. Then, select the *‘Samsung Telephony Service Provider’ and click
the [Change/Remove] button.

@on

Ef Add/Remove Programs i =]

Currently installed programs: Sort by:l Mame - l
T - e
i3 Activex Control Size 920KB =l
ﬁ Adobe Acrobat 6.0 Professional Size 354MB
isler Size 784KB
ﬁ! Java 2 Runtime Environment, SE v1.4,0_03 Size 1.73ME
ﬁ! Java 2 SDK, SE v1.4.0_03 Size 1.89ME
[ 1ava weh Start Size 1.94MB
q Microsoft Office 2000 Professional Size 185MEB

il OfficeSery OpenTSP Driver

b From wour e —

Snaglt & Size 12.0MB
ﬁ! Spothews 2,2 Size QEEKE
[ univiEw Size 47.9MB
i windows 2000 Service Pack 2 z

Close |

Figure 2.26 Add/Delete Program
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2) Among the radio buttons, select the ‘Remove’ item and click the [Next>] button.

InstallShield Wizard

Welcome

Modity, repair, or remove the program.

Wielcome to the OffizeSery OpenT SP Driver Setup Maintenance pragram. This program lets
wou modify the curent installation. Click one of the options below.

 Madify

Select new program components to add or select cumently installad
components (o remave.

" Repair
@ Reinstall all program compaonents inzstalled by the previous setup.

¢ Remave

@ Remove all installed components.

InztallShield

< Back | Mext > [:I Cancel

Figure 2.27 Delete Window

3) Click [OK] on the below message window confirming the removal of the
OpenTSP driver files.

Confirm File Deletion x|

Do wou wank ko completely remove the selected application and all of its components?

ok I Cancel |

Figure 2.28 Confirm Deletion

4) The window below appears to confirm the deletion of the C:\WINNT\System32
\SCT32.TSP file. Click the [Retry] button to delete this file.

Locked File Detected x|

An option you selected requires that files be ingtalled to or uninstalled from
vour spstem, or both, & locked file, D:AWINNTYSyetem32WSCTSP32. TSP,
waz found while perfarming the needed file operationz. To leave thiz file az it iz
oh pour eystern, click the lgnore buttan; to retr the file aperation, click Retmy;
or to perforni the operation when your spstem is rebooted, click Rebaoot.

™ Don't display this message again.

Feboot | lgrore I Rty M Cancel

Figure 2.29 Confirm File Deletion
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5) Files related to the OpenTSP driver are removed from the system. Click the
[Finish] button on the screen below.

Installshield Wizard

Maintenance Complete

InztallShield Wizard has finished performing maintenance
operations on OfficeSery DpenTSF Dnver.

< Back I Finizh I LCance

Figure 2.30 Deletion Complete
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OpenTSP Window Description

This chapter provides description on the screens, toolbars, and buttons of the various
tools offered by the OpenTSP.

Tools provided by the OpenTSP are displayed as five submenus under the ‘Programs
->Samsung Telephone Service Provider’.

A e ey

[ acrobat Distiler 6.0
Eﬂ Adobe Acrobat 6.0 Professional

Windows Update

E CfficeSery OpenTSP Driver 4 ﬁ Message Viewer
il ¥ = OpenTSP Config Tool
Docurnents 3 & Scavenger Tool

E Tapi Browser Tool
rﬂ‘ Tapi Sampler Tool

Settings L4

Search 4

Help

2000 Professional
&% | e &HE LY

Run...

Log OFf Administrator. ..

Shut Down, ..

Figure 3.1 TSP Submenu

Tools provided by the OpenTSP are as follows :
*  OpenTSP Config Tool

* Message Viewer

*  Scavenger Tool

* TAPI Browser Tool

e TAPI Sampler
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1 OpenTSP Config Tool

The OpenTSP Config Tool allows the user to set the network information, Trace Type,
and the License Key of the OfficeServ Link, to which the TSP connects.

7= 0penTSP Configuration Tool ﬂ

— Connect to Server [ OfficeSery Link |
Server IP Address | 165.213.83.88
Server Port Mo | G000
— Trace Type
* Maone " Levell " Level 2

0k, |

Figure 3.2 OpenTSP Config Tool Screen

» Server IP Address : Enter the IP address of the computer where the OfficeServ
Link is installed. The OfficeServ Link program may or may not be installed and
operated on the same computer where the OpenTSP driver is installed.

e Server Port No : This is the number of the port where the OfficeServ Link
program is waiting for connection. The default number is 6000. This port
number should be set as the same port number set at the OfficeServ Link
program.

* Trace Type : The OpenTSP driver displays its operation data through the
Tool(DBGView.exe). Set the details of the operation data to be displayed.

— None : No display(default)
— Level 1: Displays only basic information.
— Level 2: Displays detail information.
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2 Message Viewer

The Message Viewer displays various events that occur on the OpenTSP driver.

& Debug¥iew on %'\ SAMSUNG_ELECTRO (local) -0 x|

File Edit Capture ©Options Computer Help

sHE | L&~ EBT| F M

i | Time | Debug Print |

n 0.0oo0o0o00  [240] [DBES] ChannelPos=0
1 3.12479453 [940] [DBES] ChannelPos=0

Figure 3.3 Message Viewer Screen

The toolbar of the “Message Viewer’ screen is described below :

Button Name Hot Key Description Remark
= Open (Ctrl + O) Opens log file saved on PC.
= Save (Ctrl + S) Saves the displayed data as log file. (0]
= Log to File (Ctrl + G) | Saves currently occurring events to both screen o
and log file.
@; Capture (Ctrl + E) Captures messages. o
a2 Capture Kernel | (Ctrl + K) Captures Kernel messages.
- Pass through (Ctrl + P) Inhibit display of Kernel messages.
Kernel
| Capture Win32 | (Ctrl + W) | Captures Win 32 messages. (0]
[ Clear (Ctrl + X) Deletes captured messages. (0]
El Auto scroll (Ctrl + A) Automatically scrolls the screen during Capture. (0]
% | Time Format (Ctrl+T) | Changes the time display mode. 0
e Filter/Highlight | (Ctrl + L) Selects messages to be filtered.
History Depth (Ctrl + H) Sets the number of messages to be captured. o
i Find (Ctrl + F) Searches messages among the captured data.

* The ‘O’ in the Remark column indicates frequently used features.
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2.1  File Menu

The File menu allows the user to save or print the displayed messages.

& Debug¥iew on %\ SAMSUNG_ELECTRO ({local) =10 =|
W Edit Capture Options Computer  Help

Minimize ko tray h | Es El i | = | dh

Plew Window. .,

Crint |

Qpen kel

Save Chrl+5

Save As...

Log ko File, .. Chrl+G

Log ko File As, ..

Prink. .. Chel+-P

Prinkt Range...

Process Crash Dump. ..

Exit
Figure 3.4 File Menu
Item Description
Minimize to tray Message Viewer is displayed not on the task bar but on the system tray at
the lower right corner of the screen.
New window Opens a new ‘Message Viewer’ window.
Open Opens log files saved in the PC.
Save Saves log files to the PC.
Save As Saves the log file as another name.
Log to File Starts to receive log files.
Log to File As Starts to receive log files as another name.
Print Prints log files.
Print Range Sets the range of the log file to be printed.
Process Crash Dump | Opens dump file.
Exit Closes the ‘Message Viewer’ window.
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2.2 Edit Menu

The Edit menu allows the user to set the level of the messages to be displayed and to
find, filter, or delete specific data of a displayed message.

& Debug¥iew on '\SAMSUNG_ELECTRO {local) - |EI|£|
File | Edit Capture Options Computer  Help
=] sopend Comment Cirl+l m BB 7| 9 | #a
— Copy ChrH-C -
£ rint |
History Depth,,.  Ctrl+H
Font...
Find... Ctrl+F
FilterfHighlight... Ctrl+L
Clear Display Chrl
Figure 3.5 Edit Menu
Item Description
Append Comment Enters command through the PC.
Copy Copies selected areas to the clipboard.
History Depth Sets the history level of the data to be retrieved.
Font Changes the font displayed on the screen.
Find Searches specific words from the displayed messages.
Filter/Highlight Sets words to filter or highlight from the displayed messages.
Clear Display Deletes all displayed messages.
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2.3 Capture Menu

The Capture menu allows the user to select various options when displaying the
events on the screen.

& Debug¥iew on 4 SAMSUNG_ELECTRO (local) - |EI|1|

File Edit | Capture Options Computer  Help

||;"' =/ v Capture Win3z2  Chrl+w I Er B 77 | < | 4

1t | Ti # Capture Kernel  Chrl+ ht |
0 0. v Pass-Through ] ChannelPos=0
w Capkure Events  Chrl+E
Log Book
Figure 3.6 Capture Menu
Item Description

Capture Win32 Captures messages displayed through the OutputDebugString function of the
Win32 application program. This option should always be selected to track
OpenTSP messages.

Capture Kernel Captures debug messages displayed by the device driver or Windows kernel.

Pass-Through Sets whether to deliver the debug messages displayed by the device driver or
Windows kernel to other kernel mode debuggers. This option does not influence
tracking the OpenTSP messages.

Capture Events Selects whether to enable the capture feature. Messages are not captured if this
option is not checked.

Log Boot Captures debut messages displayed by the Windows kernel during booting.
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2.4 Option Menu

The Option menu allows the user to select various options of the Message Viewer.

& Debug¥iew on %\ SAMSUNG_ELECTRO (local) = |EI|5|

File Edit Capture | Options Computer  Help

W@ | EEEE
¥ Force Carriage Returns
# | Tine |

Clock, Time Chrl+T
Shicw Milliseconds

Hide Toalbar Ctrl+E
v Auko Scroll Chrl+A,
Always On Top

Figure 3.7 Option Menu

Item

Description

Win32 PIDs

Select whether to display the process id(process name in Windows 98) in

the Debug Print column.

Force Carriage Returns

Select whether to change lines for every new message.

Clock Time

Select the time display format.
- Selected : Time column displays the actual time.
- Not selected : Displays time elapsed from the first message.

Show Milliseconds

Select whether to display the clock time in milliseconds.

Hide Toolbar Hides or shows the toolbar.
Auto Scroll Automatically scrolls the screen to show newly displayed messages.
Always On Top Allows the ‘Message Viewer’ window to always be shown and not covered

by other windows.

© SAMSUNG Electronics Co., Ltd.
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2.5 Computer Menu

The Computer menu allows the user to set or display data related to the PC to which
the Message Viewer is connected.

& Debug¥iew on \\SAMSUNG_ELECTRO {local) - |EI|5|
File Edit Capture Options | Computer Help
| = E ﬂ | Connect. .. | %

Caonnect Local

# | Tine | D=
0 0.00000000 [9

Discanneck I

= SAMSUNG_ELECTRO {lacal)

Figure 3.8 Computer Menu

Item Description

Connect Enter the IP address of the PC to which the ‘Message Viewer’ should connect.

Connect Local Connects the ‘Message Viewer’' to the PC where the ‘Message Viewer’ is
installed. The ‘Message Viewer’ connects to the Local PC by default.

Disconnect Disconnects connection to the PC.

Name(local) Displays the current account(name).
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2.6 Help Menu

The Help menu allows the user to use help screen or version of the Message Viewer.

& Debug¥iew on 44 SAMSUNG_ELECTRO (local) i [m] A

File Edit Capture Options Computer | Help

sEHE s~ A B 7 | #
About

¥ | Time | Debug Prime—-— I

Figure 3.9 Help Menu

Item Description
Help Displays help for the ‘Message Viewer’ window.
About Displays version of the ‘Message Viewer’ window.
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3 Scavenger Tool

The Scavenger Tool allows the user to initialize the TSP driver without restarting the
driver during operation.

Samsung Electronics Co., Lid.

Figure 3.10 Scavenger Tool

Item Description
Setup Displays the Scavenger option setup screen.
On the option setup screen, select the phone line from which the Garbage Call
should be removed and reserve the operation time.
Close Sends the Scavenger Tool to the system tray.
Exit Closes the Scavenger Tool.

Page 3-10
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4

TAPI Browser Tool

The TAPI Browser allows the user to execute the TSP driver for each TAPI function
and view the execution result.

I [=[ 3]

|: Param: LApo{ LAp-lLine*l Line-l Call+

Call-l F'Ap¢| F‘Ap-lphm{ F‘ho-l E’I

[

lineGetDevCaps d
lineGetDevCapsin'
lineGetDevConfig
lineGetD ewConfigha
lineGetlcon

lir 3
lineGetlD
lineGetl D
lineGetlineD evStat
lineGetlinel evStat
lineGetiessage
lineGeth ewCalls

line etMumBings
lineGetProviderist

lineGetProvideristy
linelGetRequest

lineG etR equests’
linelGetStatustlessa
lineGetTranslateCap
lineGetTranzlateCap
lineH andoff
lineHanduaffw

lineHold

linelnitialize |

K

=

Figure 3.11 TAPI Browser Tool

Buttons on the toolbar are described below :

Item Description
Param Displays a window where parameters for each function are shown.
LAp+ Initializes TAPI.
LAp- Shut downs TAPI.
Line+ Opens the phone line.
Line- Closes the phone line.
Call+ Makes the call.
Call- Disconnects the call.
PAp+ The OpenTSP does not support these commands for Phone Device.
PAp-
Pho+
Pho-
Clear Deletes data on the window to the right where TAPI messages are displayed.
[blank] The user can customize this button.

© SAMSUNG Electronics Co., Ltd.
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4.1 File Menu

The File menu allows the user to delete displayed messages or to set parameters
required for the operation of the TAPI browser.

T TA

. ol
File Options  Help
m LAp-lLinevl Line-lCaII+ Call-l PAmlF'Ap-lF’ho*l Pho-l E’I I I | | | |
Params j ;I
Exit
Inelefl) evlonng'
lineGetlcon
Figure 3.12 File Menu
Item Description
Clear Deletes messages displayed on screen.
Params Displays a window where parameters for each function are shown.
Exit Closes the ‘TAPI Browser Tool'.

4.2 Option Menu

The Option menu allows the user to set the options or specifics required when
executing each TAPI function through the TAPI browser.

File | Options ID
- - I Y o[+ o] [ ] | | | |

lineGe  User buttons...

ineGe  Log parameters
lineGe  Log structures s

Show time starnps

Record log file

v Auto-deallocate idle monitored calls
lineGe  Auto-deallocate idle owned calls
lineGe
lineGe  Disable handle checking

lirve G eTFTaviderCR T T

Figure 3.13 Option Menu

Item Description
Default values Sets the default values of the TAPI Brower.
User buttons Creates user-defined buttons.
Log parameters Displays the parameters along with the message.
Log structures Selects the display format for the structure.
Show time stamps Displays the time stamp in front of messages.
Record log file Saves the log to file.
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Item Description
Auto-deallocate idle Automatically removes the idle call handle of the Monitor authority. This
monitored calls option is checked by default.
Auto-deallocate idle Automatically removes the idle call handle of the Owner authority.
owned calls Checking is recommended.
Disable handle checking | Does not check the call handle. Checking is not recommended.

4.3 Help Menu

The Help menu provides instruction and version of the TAPI Browser.

! ¢ Browser —I—I' Dﬁl
File Dptions | Help

[ Param: L.t'-\p:| m Call-| Pap+Pap-|PhoH Pho- Elea!|
|IineGetDeanps About TH, ., | ;l
lineGetDevCans

Figure 3.14 Help Menu

Item Description
Using TB Displays a summarized guideline for the ‘TAPI Browser’.
About TB Displays the version of the ‘TAPI Browser’.
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5 TAPI Sampler

The TAPI Sampler is a utility program that dials, receives, or disconnects calls
through the OpenTSP driver or displays various TAPI events received by the
application programs through the TAPI service.

Start the TAPI Sampler while the OfficeServ Link program is normally operating to
display the screen below.

m samsung TAPI Sampler - MORE =

My Extention: | A0 I Open |

Destination: |

Dial |

Time

| CallHandle | CallState [ CallStat,., | Connec.., |

Call Status
Window

Tirne

| Event

Message Status
Window

Figure 3.15 TAPI Sampler Screen

As shown above, the TAPI Sampler is simply configured.

* My Extension : Select the number of the device to be sued by the TAPI Sampler.

* Destination : Enter the destination number for an intercom/external call.

* Call Status Window : Displays the progress of call origination/termination.

*  Detail Message Information Window : Displays detail information on messages
the TAPI Sampler received through the TAPI service.

Page 3-14
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Call Status Window

Parameters of the Call Status Window are as follows :

Parameter Description
Time Time when the event occurred.
CallHandle Call Handle. Displayed in 4 byte hexadecimal.
CallState Displays the call status as Idle, Connected, Busy, etc
CallStatDetail Displays additional information, if any, on the call status.
ConnectedID Displays the phone number of the other party.

Message Status Window

Parameters of the Message Status Window are as follows :

Parameter Description
Time Time when the event was received.
Event Displays details on the received event.
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CHAPTER 4
OpenTSP Driver Guide

This chapter describes the procedure on dialing, receiving, and disconnecting calls
using the OpenTSP driver after successfully installing the driver on the PC.

The tools or programs used for procedures from setting the environment to
processing calls are as follows.

Step ltem Used Tool(Program)
1) Environment Setup Set IP address and port | Phone and Modem Options(Advanced tab),
OpenTSP Config Tool
Set Trace type Phone and Modem Options(Advanced tab),
OpenTSP Config Tool
Set Dialing Rules Edit location of Phone and Modem Options

(Refer to ‘1.3 Checking Telephony Service’
in Chapter 2.)

2) Call Processing Dialing, receiving, or Programs—>Accessories=>Communication
disconnecting calls ->Dial, TAPI Sampler
3) Checking Call OpenTSP driver Programs—>Accessories>Communicati
Processing Messages | operation status on —>Dial, Message viewer, TAPI32 Browser
Execute OpenTSP TAPI | TAPI32 Browser
call function

Receive call processing Message viewer

result log
o TAPI Compatible Application Program
O TAPI Compatible Application Program can be used when the OfficeServ Link program
CHECK to be connected to through the OpenTSP driver is normally operating.
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1  Environment Setup Procedure

There are two ways to set the environment for setting the IP address and port, for
selecting the Trace type, and for entering the license key.

*  Phone and Modem Options(Advanced tab)

e OpenTSP Config Tool

1.1 Setup through the Phone and Modem Options (Advanced tab)

Procedure for setting the environment through the Phone and Modem
Options(Advanced tab) of the OS is as follows :

1) Select “Start-> Settings—> Control Panel’ on the computer.

e

‘“Windows Update

| Programs »

Docurnents

SettiTies B3 Contral Panel

5 Metwork and Dial-up Connections
Printers
Help a Taskbar & Stark Menu...

Search

Run...

Log OFf Administratar...

Shut Down,..

Figure 4.1 Starting Control Panel

2) Select the “Phone and Modem Options from the ‘Control Panel’ shown below.

=

J File Edit Wew Favorites Tools Help |

J 4=Eock ~ = - | Qsearch  [YFclders  £HHistory "ﬁ 0 x @ | Ed~

J Address I@ Cantral Panel j @GD
= el = @?? [€] Accesshiliey Options
L %Addp’Remove Hardware Add,l’Remove Programs
& (@) Adrministrative Taols @ Drate/Time
Control Panel Dlsplay q’Fnlder Options
[ Forts %Game Controllers
Phone and Modem Options @Intemet Options @Java Plug-in 1.4.0_03
Configures your telephone dialing ruIes%Keyhnard Q Mouse
and modem properties Metwork and Dial-up Connections  SREJIEEE
wWindows Update ?J‘-lPuwer Options Printers
‘Windows 2000 Support @Reg\onal Opkions aScanners and Cameras
(@] Scheduled Tasks \EJQSounds and Multimedia
{3 system b Users and Passwords
onfigures vour telephone dialing rules and modem properties | |@. My Computer 4

Figure 4.2 Selecting Phone and Modem Options
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3) Click the [Edit(E)] button on the ‘Phone and Modem Options’ window.

Phone And Modem Options

d b

Dialing Fules I Modemsl Advancedl

& The list below dizplays the locations you have specified. Select the
e location fram which wou are dialing.
Locations:

Lacation | Area Code I
(O] My Location 02

Mew... Edit... Delste

[ o 1]

Cancel Apply

Figure 4.3 Phone and Modem Options Window

5) Select the ‘Advanced’ tab on the ‘Phone and Modem Options’ window.

Phone And Modem Options

2]

Drialing Hulesl Modems  Advanced |

2y
2

Providers:

The following telephony providers are inztalled on this computer:

HDIS Prosy TAPI Service Provider

Sarzung OfficeSery OpenTSP Driver for Keyphone Series
TaP! KemelMode Service Provider

Unimaodem 5 Service Provider

Add... | Remave | Configure...l

Cloze I

Cancel | Apply |

Figure 4.4 Advanced Tab of Phone and Modem Options Window

© SAMSUNG Electronics Co., Ltd.
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6) Select the ‘Samsung SCTSP32 TAPI 2.x Compatible Telephone Service
Provider’ and click the [Configure(C)] button.

Phone And Modem Options 21 x|

Dialing Rules I Modems Advanced |
;@ The following telephony providers are installed on this computer:

Providers:

Microsaft H.323 TAPI Service Provider
Microsoft Multicast Conference TAPI Service Provider
HDIS Prowy TAP] Service Provider

Samzung DfficeSery OpenT SP Driver for Keyphone Series
TAP! Kemel-Mode Service Provider
Unimodern 5 Service Provider

Add... | Femove | Eonfigure...l

Cloze | Cance| | Apply |

Figure 4.5 Selecting Configure Button of Advanced Tab

7) Enter the fields of the ‘Communication Parameters’ window and click the [OK]
button.

Communication Parameters Xl

— Connect to Server [ OfficeSery Link ]

Server P Address

Server Port Mo I G000

— Trace Type
* Mone = Levell 1 Level2

ak | | Cancel | | About

Figure 4.6 Communication Parameters Window

e Server IP Address : IP address of the PC where the OfficeServ Link is installed.

* Server Port No : Use the default number, 6000.(This port number should be set
as the same port number set at the OfficeServ Link program.)

* Trace Type : Select ‘Level 1’ or ‘Level 2’ to display call processing messages or
select ‘None’ not to display messages.
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1.2 Setup through OpenTSP Config Tool

Procedure for setting the OpenTSP driver environment through the OpenTSP Config
Tool is as follows :

1) Execute the ‘OpenTSP Config Tool’ under the “Start->Programs—> Samsung
Telephony Service Provider’. The screen below is displayed.

@on

OfficeSery OpenTSP Driver |

Before changing each configuration walue, wou have to stop all tapi applications at Firsk,

Figure 4.7 Closing TAPI Compatible Program

2) The message above informs the user that all TAPI compatible programs need to
be closed before changing the environment settings. Close all TAPI compatible
programs that are currently operating and click the [OK] button.

3) Enter the fields in the window shown below and click the [OK] button.

== OpenTSP Configuration Tool ﬂ
— Connect to Server [ OfficeSery Link |
Server IP Address | 165.213.88.88
Server PatMao: | 6000
— Trace Type
f* Mone = Level1 = Level 2
] 4

Figure 4.8 OpenTSP Config Tool
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2 Call Processing

2.1 Call Processing of the Phone Dialer Program

A dialing program is basically installed in all versions of Windows OS.

Dialing Procedure

Procedure for dialing through the ‘Phone Dialer’ is as follows :
1) Connect the Samsung Key telephone system and the OfficeServ Link program
through the CTI link.

2) Execute the ‘Phone Dialer’ program of the OS by clicking [Start->Programs—>
Accessories—> Communication—->Phone Dialer]. The ‘Phone Dialer’ screen
shown below appears.

-loix]

File Edit ‘iew Phone Windows Help

[ T 5B W‘«J

Dial Redial Speed e Jain Leaye Refresh  Hide Calls  Prewview

% Directories |
E@ Internet Directories
: {1y Metwork)

-1 People

Tao add a new directory use the Add Direckary command in the Edit menu, The
directories contain people and conferences that can receive Internet calls,

------ |Z7 Conferences

S5y My Metwork Directory
.-£22 Speed Dial

@ Conference Room

Far Help, press F1 v

Figure 4.9 Phone Dialer Screen

3) Select [Edit>Option] and display the screen below.
options 20 x|

Lines | udio #vides |

Phone and Modem Options... |

— Preferred Line For Calling
@' ¢ Phone Q  Internet

r— Line Uged For
¢ Phone Calls: |<.&uto-SeIect> j
Q Intemet Calls: Imuto-SeIect} j
@ Internet Conferences: |<Auto-SeIect> j

Ok, I Cancel | Lpply |

Figure 4.10 Option Screen
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Default line for dialing : Select “Telephone’ since the OpenTSP driver is used for

line telephones.

— Telephone(O) : Selects the communication line for line telephones.
Internet(N) : Selects the communication line for Internet lines.

Used lines : Applies according to the default line used for dialing.

— Phone(P) : Sets telephone lines. This number should be identical to the
actual phone number of the Samsung switch.

— Internet Communication(l) :

— Internet Conference(F) :

4) The settings of the ‘Line’ tab are displayed below. The ‘DCS Line 2001’ in the
‘Phone’ field represents that the extension number is 2001. The OpenTSP driver
displays the device list of the Samsung key telephone system as ‘DCS Line

XXXX(extension number)’.
options 2| x|
Lines | Audio /videa |

@ Phore and bModern Options. .. |

— Preferred Line For Calling

% % Phone = Intemet
—Line Uzed For
@ Phaone Calls:
Q Internet Calls: |<.-'1'-.ut|:|-5nelect> j
@ Internet Conferences: I<.-'-‘-.utu::-5&|eu:t> j

] I Cancel | Apply |

Figure 4.11 Line Tab of Option Screen
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5) Select the *Audio/Video(A)’ tab and check if the ‘Line’ item of the ‘Dialing
Device’ is set to Telephone, and click the [OK] button.

e — 2%

Lines  Audio / Video |

ﬁ)/i Sound Settings... |
B

— Devices Used For Calling

@ (N | Phone Calls

)@ Audio Record: |<No devices detected:

<}]§ Audio Playback: |<No devices detecteds

ﬁ] Video Record: |<No devices detected:

¥ | Yiden Playback

L el |

[ o |

Cancel I Apply

Figure 4.12 Audio/Video Tab of Option Screen

6) From the ‘Phone Dialer’ screen below, click ‘Phone—>Dial’.

#7 Phone Dialer (=] B
File Edit View | Phone Windows Help

z ¢wINEEER = o

Dial Ret Redial 2 Join Leayve
£ Directories Speed Dial 4 |

E@ Internet O

-8 (My Ne 45 Mew Conference...
CI Pe E]# Join Conference. .
[ S |eave Conference

“

%
Refresh  HideCalls  Preview

IS Conference Room

Place a phone, Internet or conference call

a new directory use the Add Directory command in the Edit menu, The
ries conkain people and conferences that can receive Inkernet calls,

Figure 4.13 Selecting Dial from Phone Dialer Screen

7) From the “Dial’ screen below, check if the *‘Dialing Pattern’ is set to Phone(P)
and enter ‘2002’ into the entry field. Then, Click the Connect(C) button.

Page 4-8

Figure 4.14 Dialing from the Dial Screen
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8) The screen below appears and shows that extension 2001 is dialing extension

2002.

Preview

L
e

Phone Call
202

A ‘Waiting for answer...

Phone Call
20

q Incoming call...

X Close

=l

?Disconnect

[ Take Call

S Reject Call

Figure 4.15 Dialing Display Screen

9) The screen below appears upon successful connection. Select Disconnect(D) to
terminate the connection after completing the call.

Preview

A

K Close

Phone Call
20

*X*  Disconnected

Phone Call
202

=} Waiting for answer...

Phone Call
20

A Incoming call...

B«

¥ Close

?Qisconnect

(2 Take Call

7 Reject Call

Figure 416 Disconnecting the Call

¢

NOTE

Checking the OpenTSP driver operation

If the OpenTSP driver is successfully connected to the TAPI service through the dialing
program, the messages exchanged can be viewed through the Message Viewer.

© SAMSUNG Electronics Co., Ltd.
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2.2 Call Processing of the TAPI Sampler

Users can dial, receive, or disconnect calls through the TAPI Sampler. The

OfficeServ Link program should be normally running to ‘Dial’ using the TAPI
program.

Dialing Calls

Procedure for dialing calls using the TAPI Sampler is as follows :

1) Click [Start->Programs—> OfficeServ OpenTSP Driver->TAPI Sampler Tool] as
shown below.

r_ Fm Offices enTSP Driver [ 3% Message Viewer
E RIS ¥ % OpenTSP Config Tool
] @ BEEES . & Scavenger Tool
= E Tapi Browser Tool
:ﬁ % Settings > Tapi Sampler Tool
E @ Search 4
: @ Help
A Rur. ..
: & Log ©ff Administrator...

] Shut Down. ..

Figure 4.17 Executing the TAPI Sampler Tool

2) Select your extension number from the ‘My Extension’ field on the screen below
and click the ‘Open’ button.

B/ 5amsung TAPI Sampler - MONE x|
My Extertion: [ZIIMGNNNNINIINNE ~|  Open
Destination: I— Dial

Time [ CallHandle | CallState | CallStat... | Connec,..

Time | Event

Figure 4.18 Selecting Extension Number
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3) Enter the destination number in the ‘Destination’ field and click the “Dial’ button.
Setting different numbers for the ‘My Extension’ and ‘Destination’ fields will
enable receiving calls through TAPI Sampler.

Ei armsung TAPI Sampler - 2001 x|

My Extention: |2001 x|  Close |
Destination: |EDDE Dial |

Time | CallHandle [ CallState | CallStat.. | Connec.., |

Time | Event |
14:36:14 2001 opened,

Figure 4.19 Selecting Destination Number

4) Information on the TAPI messages, sent to the TAPI Sampler by the TAPI
service, are displayed ‘Message Status Window’.

sung TAPI Sampler - 2001 x|

My Extention: |2001 x|  Close |

Destination: |EDDE

Time | CallHandle [ CallState | CallStat.. | Connec.., |

14:38:18  0=00010399 Ringback 2002

Time | Event |
14:38:18 LIMECALLSTATE_DIALTOME received

14:38:18  LINECALLSTATE_RINGEACK, received

14:38:18  LINECALLIMNFO on 0x00010399 received

14:38:18 LIMECALLIMFO: 000010399

duw TotalSize=0:000001a8 dwheededSize=0:0000,,
hLine=0=000103dd dwlineDeviecelD=0=00000005
dwe Trunk=0sAf - 1)
CalledID=2002
Connected|D=2002
Samsung T&PI Sampler

< |

Figure 4.20 TAPI Message Display Screen
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Receiving Calls

Calls may also be received through the TAPI Sampler program.

A call is being sent from extension 2002 to extension 2001 in the figure below.

The Call Status Window displays information on the call, such as time of event, call
status, and destination number, and the Message Status Window displays detail
information on the TAPI messages sent to the TAPI Sampler by the TAPI service.

If a call arrives, right click the information of the call on the Call Status Window to
display the Context Menu as shown below. Select [Answer] to answer the call.

Samsung TAPI Sampler - 2001 5;3 x|

My Extention: |2001 =] &I

Destination:  [2002 Dial |

| Tirme | CallHandle | CallState | CallStat,,, | Connec,.,
A —— LR

™ Calllnfo
o Answeer |_'|
Drap
Time [ Event Deallocate |

14:40:50  |DLE Call Handle {0x00010344) deallocated
14:40:52  LINECALLSTATE_OFFERING received
14:40:52  LINECALLIMFO on 0x00010322 received
14062 LINECALLINFO: 0x00010322
dw TotalSize=0:00000138 dwileededSize=0:0000,,
hLine=0:000103dd dwLineDeviecelD=0x00000005 ,,
duwr Trunlk=0xfiffifi 1)
CallerlD=2003

CalledID=20M
Connected|D=2003 =
4| | »

Figure 4.21 Context Menu Display Screen

The Context Menu is described as follows :

* Callinfo : Displays Detail information on the call on the Message Status Window.
This feature displays the result of the TAPI function, lineGetCallInfo().

*  Answer : Answers the call.

* Drop : Disconnects the connected call.

* Deallocate: Clears all displayed call information regardless of the phone status.
This feature initializes the line device managed by OpenTSP driver and deletes
all call data on the corresponding line.(Impertinent to the actual status of the
device) This feature appends the inconsistency between the status of the actual
phone and the status data of the line device.
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3 Checking Call Processing Messages through the
Message Viewer

The Message Viewer is used for verifying the messages processed during the
operation of the OpenTSP driver.

Downloading the DBGView.exe file
As the execution file of the Message Viewer, the DBGView.exe is installed along with

NOTE  the OpenTSP driver. Made by Sysinternal, this program is used for logging debug
messages within the Windows OS. Download and update your DBGView.exe file
from http://www.sysintenal.com.

1) Click [Start->Programs—>OfficeServ OpenTSP Driver-> TAPI Sampler Tool] as
shown below :

r_ Bn OfficeSery OpenTSP Driver L4 ﬁ Message Yiewer
[ Frograms ¥ % OpenTsP Config Tool
- @ Do b & Scavenger Todl
& E Tapi Browser Tool
'.g % Settings L4 Tapi Sampler Toal
E @ Search 4
z @ Help
i Rur...
§ & Log Off Administrator, ..

Shut Down, ..

Figure 4.22 Executing the TAPI Sampler Tool

2) The Message Viewer screen below appears and displays the messages exchanged
during the operation of the OpenTSP driver.

= Dabughiew on WHAMAMIYA (local) ~10l %]

File Edit Capmre Options Computer Help
sEHA 4 @F-A BT T M

# [ Time [ Debug Print

1 | 3

Figure 4.23 Message Viewer Screen
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Setting the message display level
Messages on the operation status of the OpenTSP driver are displayed on the
NOTE Message viewer only when the Trace Type, the OpenTSP driver’s environment setup

item, is set to ‘Level 1’ or ‘Level 2', and are not displayed when the Trace Type is set
to ‘None’.

@ Verifying the operation of the OpenTSP driver

Through the Message Viewer, users can view detail messages related to the
NOTE operation of the OpenTSP driver and can also save the displayed messages as files if
necessary.
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CHAPTER 5

TAPI Functions

This chapter describes the features of the TAPI functions and expansion functions
that the OpenTSP driver supports.

1 Relationship Between the TAPI and TSPI

When the TAPI-compatible application requests a TAPI function, the Telephony
Service Provider provides the TSPI functions related to the TAPI function. That is,
the TAPI-compatible application receives the TAPI service offered by the key
telephone system through the Telephony Service Provider.

The procedure for exchanging messages between the TAPI and TSPI is shown in the
figure below :

PC Key Telephone System

TAPI-Compatible e

Application ‘ ® @ CTI Service
_ @ Telephony Service |+ J >
Operating System Provider

Figure 5.1 Flow of Messages Between the TAPI and TSPI

Each step shown in Figure 5.1 is described below :

@

© ® © 0

The TAPI-compatible application calls a TSPI function to the TAPI service of
the key telephone system in order to process calls.

The TAPI-compatible application calls a TSPI function to the Telephony
Service Provider.

The Telephony Service Provider forwards the event requested by the TAPI-
compatible application to the TAPI service of the key telephone system.

The TAPI service of the key telephone system processes the event and notifies
the Telephony Service Provider of the results.

The Telephony Service Provider forwards the results received from the CTI
service of the key telephone system to the TAPI-compatible application.
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Example of Internal Calling Using the Phone Dialer

Figure 5.2 shows the procedures for using the phone dialer offered by the PC to make
a call from Extension 2001 to Extension 2002 :

PC
Phone Dialer
A

@ ®

v

TAP! Service Key Telophons System
@

v @ ®
OpenTSP Driver 3 A OfficeServ Link [ ) CTI Service

©) @

Figure 5.2 Example of Internal Calling in the Phone Dialer

The commands and events to be sent or received during internal calling are processed
as described below :

@

@

Q ©® © &

®

lineMakeCall : The Phone Dialer uses the lineMakeCall TAPI function to press
Extension 2002 for making a call.

TSPI_lineMakeCall : The TAPI service calls the TSPI_lineMakeCall function to
the OpenTSP driver after being asked to process the TAPI function.

The OpenTSP driver creates the command that can be processed by the key
telephone system and forwards it to the OfficeServ Link program in order to
perform the functions requested by the TAPI service.

The OfficeServ Link forwards the command received from each OpenTSP
driver to the key telephone system of Samsung.

The key telephone system interprets the forwarded command to make a call
from Extension 2001 to Extension 2002.

The key telephone system forwards the extension processing results to the
OfficeServ Link.

The OfficeServ Link forwards the extension processing results received from the
key telephone system to the OpenTSP driver.

The OpenTSP driver converts the event for the processing results into the form
that can be processed by the TAPI service and forwards the event to the TAPI
service.

The TAPI service forwards the results for TAPI function processing to the
Phone Dialer through the TAPI service.

Once the steps above are completed, the Phone Dialer offers the call processing
results to users through an internal processing module.
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List of the TAPI Functions

Restriction

The OpenTSP driver supports INTERACTIVEVOICE mode and only the Line
Device function out of the list of the TAPI functions of Microsoft.

List of the TAPI Functions

The list of the TAPI functions that the OpenTSP driver enables is shown below :

TAPI Functions of Supported
Microsoft or Not Remarks

LineAddToConference (0] Consultation Call

LineAnswer o Off-Hook

LineBlindTransfer o Consultation Call+Transfer

LineClose ®)

LineCompleteCall (6] Camp on+Msg Waiting+OHVA+Callback

LineCompleteTransfer O Transfer

LineDeallocateCall O Idle Call Remove

LineDevSpecific (0] Refer to 5.3 List of the OpenTSP Driver Expansion
Functions.

LineDial (0] Make Call

LineDrop 0] On-Hook

LineForward (0] Set/Reset Forward/DND

LineGenerateDigits O Send DTMF Digits

LineGetAddressCaps (@]

LineGetAddressID (0]

LineGetAddressStatus (0]

LineGetCalllnfo (0]

LineGetCallStatus O

LineGetDevCaps (0]

LineGetDevConfig (@]

LineGetlD O

LineGetLineDevStatus (0]

LineHold (0] Hold

lineMakeCall (0] Make Call

lineNegotiateExtVersion (0]

lineOpen O

linePark O Direct Park : OK, UnDirect Park[=System Hold] : OK

linePickup (0] Direct Pickup+Group Pickup

© SAMSUNG Electronics Co., Ltd.
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TAPI Functions of Microsoft Supported Remarks
or Not
linePrepareAddToConference o Consultation Call
lineRedirect (0] Redirect
linePark (0] Direct Park : OK, UnDirect Park[=System Hold] : OK
lineRemoveFromConference O Consultation Call
lineSetAppSpecific (0]
LineSetCallData (e}
lineSetCallParams ¢}
lineSetMediaMode (¢}
lineSetStatusMessages (0]
lineSetupConference O Consultation Call
lineSetupTransfer (0] Consultation Call
lineSwapHold (0] Consultation Call for T-Hold And Hold+Retrieve for
S-Hold
lineUnhold (@) Consultation Call for T-Hold and Retrieve for S-Hold
lineUnpark (6] System Hold Retrieval

The list above shows only the TAPI functions supported by the OpenTSP driver :
Some functions from the list of the TAPI functions might be processed by the TAPI
service itself. Also, some functions, which are used to add the Telephony Service
Provider to the system, are not included in the list. If the functions that are not
supported by the OpenTSP driver are called, an error message defined in the TAPI

will appear.

The user can find the entire list of the Microsoft TAPI functions from the Microsoft
site(http://www.msdn.microsoft.com/library/default.asp). The user can check the
format of each function, how to use the functions, or the status values returned from
the list and refer to the list to develop an application.
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Figure 5.3 URL of the Entire List of Microsoft TAPI Functions
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Feature List of the Expansion Functions in the
OpenTSP Driver

Besides the functions defined by the TAPI, the OpenTSP driver provides a variety of
expansion functions. Call the lineDevSpecific function to use the expansion functions.

Enter the syntax below to call the lineDevSpecific function :

LONG lineDevSpecific(HLINE hLine, DWORD dwAddressiD, HCALL hCall,
LPVOID IpParams, DWORD dwSize);

The features available by the lineDevSpecific function in the Samsung key telephone
system are as follows :

e  Station Lock

*  Vacant Station Message
* Follow Me

* Make New Trunk Call

* Page

e System Hold Retrieval
*  Clear Message Waiting
* Clear Call Back

* OHVA

*  Silent Monitoring

*  Mute On/Off

* Line Reset
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3.1 Station Lock

The Station Lock disables other users from using their own phones to make or
answer calls.

The available modes are as follows :
¢ Unlock : Release lock.
* Locked all : Lock call outgoing and incoming.

Enter the syntax below to call the lineDevSpecific function when the Station Lock is
used in the TAPI application:

LONG [lineDevSpecific(HLINE hLine, DWORD dwAddressiID, HCALL hcCall,
LPVOID IpParams, DWORD dwSize);

Input Parameter Values

hLine : Processes the lines to be used.

dwAddressID : 0

hCall : Not used

IpParams : Enters the command strings as shown below :

Value Byte
‘D''C''S 3 Bytes
v 1 Byte
Option : 1 Byte
0-Unlock
2-Lock All
Phone Password Up to 4 bytes

* DwsSize : Buffer length(Null value included)
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Vacant Station Message
The Vacant Station Message enables the phone to display a vacant message on the

LED of the caller’s extension phone when a user sets the ‘vacant message’ to the
user’s phone before he or she is away from the phone.

Number of Vacant Messages
The number of vacant messages that can be set to the system depends on the

NOTE Samsung key telephone systems.

Enter the syntax below to call the lineDevSpecific function when the Vacant Station
Message is used in the TAPI application:

LONG DlineDevSpecific(HLINE hLine, DWORD dwAddressiD, HCALL hCall,
LPVOID IpParams, DWORD dwSize);

Input Parameter Values

* hLine : Processes the lines to be used.

e dwAddressiD : 0

e hCall : Not used

e |IpParams : Enters the command strings as shown below :
*  DwsSize : Buffer length(Null value included)

Value Byte
‘D'C'S 3 Bytes
A% 1 Byte
Message number(Hexa value) : 1 Byte

0-Clears a message.

1~20-Number of the messages

© SAMSUNG Electronics Co., Ltd.



OfficeServ OpenTSP Driver Description/Ed.00 CHAPTER 5. TAPI Functions

3.3 Follow Me

The Follow Me enables call forwarding so that the user can answer a call even if the
user is away from the phone. This feature is the same as “call forwarding
unconditional.” However, the “call forwarding unconditional’ is set in the user’s
phone while the Follow Me is set in another phone.

Enter the syntax below to call the lineDevSpecific function when the Follow Me is
used in the TAPI application :

LONG lineDevSpecific(HLINE hLine, DWORD dwAddressiD, HCALL hcCall,
LPVOID IpParams, DWORD dwSize);

Input Parameter Values

* hLine : Processes the lines to be used.

* dwAddressiD : 0

* hCall : Not used

* IpParams : Enters the command strings as shown below :
e DwsSize : Buffer length(Null value included)

Value Byte
‘D'‘'C''S 3 Bytes
‘" 1 Byte
Phone number to be forwarded Up to 4 Bytes
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Make New Trunk Call

The Make New Trunk Call enables the user to make a trunk call continuously without
making the call again even after the trunk call is completed.

Enter the syntax below to call the lineDevSpecific function when the Make New
Trunk Call is used in the TAPI application :

LONG [lineDevSpecific(HLINE hLine, DWORD dwAddressiD, HCALL hCall,
LPVOID IpParams, DWORD dwSize);

Input Parameter Values

* HLine : Processes the lines to be used.

e dwAddressID : 0

* hCall : Not used

* |pParams : Enters the command strings as shown below :
* DwsSize : Buffer length(Null value included)

Value Byte
‘D'C'S 3 Bytes
T 1 Byte
Digit of the dialed phone number-n 1 Byte
Digit to be dialed n Byte(s)
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3.5 Page

The Page enables the user to give a notice to people simultaneously through the
speaker installed on the key telephone(or the external speaker installed separately).
The page is categorized into internal page and external page. The internal page is
made to the key phones, which are set as the internal page zone of the current key
telephone system. The external page is made through the speakers, which are set as
the external page zone. When the external page is made, an external speaker should
be set in the <System Programming> of the Samsung key telephone system.

Enter the syntax below to call the lineDevSpecific function when the Page is used in
the TAPI application:

LONG [lineDevSpecific(HLINE hLine, DWORD dwAddressiID, HCALL hcCall,
LPVOID IpParams, DWORD dwSize);

Input Parameter Values

* hLine : Processes the lines to be used.

e dwAddressID : 0

* hCall : Not used

* |pParams : Enters the command strings as shown below :
* DwsSize : Buffer length(Null value included)

Value Byte
‘D 'C'S 3 Bytes
P 1 Byte
Number of page 1 Byte

The page zone numbers are described below :
e ‘1’~‘4’:Internal page zone

e ‘5’~‘8’: External page zone

e ‘0’: Entire internal page

e ‘O’: Entire external page

e “**:Entire internal/external page
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System Hold Retrieval

The System Hold Retrieval enables the user to ‘hold” an incoming call momentarily
and answer the call from another extension.

Enter the syntax below to call the lineDevSpecific function when the System Hold
Retrieval is used in the TAPI application:

LONG DlineDevSpecific(HLINE hLine, DWORD dwAddressiD, HCALL hcCall,
LPVOID IpParams, DWORD dwSize);

Input Parameter Values

* hLine : Processes the lines to be used.

e dwAddressID : 0

* hCall : Not used

* |pParams : Enters the command strings as shown below :
* DwsSize : Buffer length(Null value included)

Value Byte
‘D'C''S 3 Bytes
‘s’ 1 Byte
Number of the calls on hold Up to 4 Bytes
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3.7 Clear Message Waiting

The Clear Message Waiting disables the message waiting LED to be displayed when
a message is left in the user’s phone.

Checking if a message has been left
In the Samsung key telephone system, the LED on the message button of the

NOTE  connected phone turns on to notify the other party that a message has been left when
a caller leaves the message because the caller cannot speak to the other party.

Enter the syntax below to call the lineDevSpecific function when the Clear Message
Waiting is used in the TAPI application :

LONG lineDevSpecific(HLINE hLine, DWORD dwAddressiD, HCALL hcCall,
LPVOID IpParams, DWORD dwSize);

Input Parameter Values

* hLine : Processes the lines to be used.

e dwAddressIiD : 0

* hCall : Not used

* IpParams : Enters the command strings as shown below :
e DwsSize : Buffer length(Null value included)

Value Byte
‘D'‘'C''S 3 Bytes
‘™ 1 Byte
Number of the devices where a message is left Up to 4 Bytes
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Clear Call Back

The Call Back enables the user to make a call reservation when the other party is on
the phone or does not answer. Then, a caller’s phone rings automatically when the
other party’s phone becomes available. The Clear Call Back disables the Call Back.

Enter the syntax below to call the lineDevSpecific function when the Call Back is
used in the TAPI application :

LONG [lineDevSpecific(HLINE hLine, DWORD dwAddressiD, HCALL hcCall,
LPVOID IpParams, DWORD dwSize);

Input Parameter Values

* hLine : Processes the lines to be used.

* dwAddressID : 0

* hCall : Not used

* |pParams : Enters the command strings as shown below :
* DwsSize : Buffer length(Null value included)

Value Byte
‘D'C'S 3 Bytes
‘c’ 1 Byte
Phone number to which a reservation has been made | Up to 4 Bytes
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3.9 OHVA

The Off Hook Voice Announcement(OHVA) enables a caller to leave a message in

the other party’s phone when the other party is on the phone. This is useful when the
caller needs to leave a message urgently.

Enter the syntax below to call the lineDevSpecific function when the OHVA is used
in the TAPI application :

LONG [lineDevSpecific(HLINE hLine, DWORD dwAddressiD, HCALL hcCall,
LPVOID IpParams, DWORD dwSize);

Input Parameter Values

* hLine : Processes the lines to be used.

e dwAddressID : 0

* hCall : Not used

* |pParams : Enters the command strings as shown below :
* DwsSize : Buffer length(Null value included)

Value Byte
‘D'C'S 3 Bytes
r 1 Byte
Phone number for the OHVA Up to 4 Bytes
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Silent Monitoring

The Silent Monitoring enables a caller to speak to the extension subscriber by
interruption even while the subscriber is on the phone. In the Samsung key telephone

system, the Silent Monitoring operates in “Without Tone(the monitored subscriber
does not the monitoring sound).’

Enter the syntax below to call the lineDevSpecific function when the Silent
Monitoring is used in the TAPI application :

LONG [lineDevSpecific(HLINE hLine, DWORD dwAddressiD, HCALL hcCall,
LPVOID IpParams, DWORD dwSize);

Input Parameter Values

* hLine : Processes the lines to be used.

e dwAddressiD : 0

* hCall : Not used

e IpParams : Enters the command strings as shown below :
*  DwsSize : Buffer length(Null value included)

Value Byte
‘D'‘C''S’ 3 Bytes
‘B’ 1 Byte
Phone number for silent monitoring Up to 4 Bytes
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3.11 Mute On/Off

The Mute On/Off enables(Mute Off) or disables(Mute On) the other party to listen to
a caller’s voice while the caller is speaking to the other party or is on the Intrude or
Silent Monitoring. Although a caller sets the Mute On, the caller can listen to the
other party’s voice.

Enter the syntax below to call the lineDevSpecific function when the Mute On/Off is
used in the TAPI application :

LONG lineDevSpecific(HLINE hLine, DWORD dwAddressiD, HCALL hcCall,
LPVOID IpParams, DWORD dwSize);

Input Parameter Values

* hLine : Processes the lines to be used.

* dwAddressiD : 0

* hCall : Not used

* IpParams : Enters the command strings as shown below :
e DwsSize : Buffer length(Null value included)

Value Byte
‘D'‘'C''S 3 Bytes
‘m’ 1 Byte
Phone number for Mute On/Off Up to 4 Bytes
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3.12 Line Reset

The Line Reset enables the user to initialize the device managed by the OpenTSP
driver forcibly when the call status of the device is different from that of the Samsung
key telephone system.

The status of calls in each device of the OpenTSP driver should be the same as that of
calls in the Samsung key telephone system. However, the device status of the PBX
might be different from the call status of the device managed by the OpenTSP driver
due to an error during the operation of the OpenTSP driver.

In this case, the request of initializing the device in the application can be made. The
initialization can be made in the two ways described below : The first way is that only
the device managed by the OpenTSP driver is initialized. That is, only the device of the
OpenTSP driver is initialized irrespective of the device status of the PBX. The second
way is that the device of the PBX is initialized along with the device of the OpenTSP
driver. The two ways of initialization can be requested by the application at a right time
if needed.

When Only the Device of the OpenTSP Driver is Initialized

* hLine : Processes the lines to be used.

e dwAddressID : 0

e hCall : Not used

* |pParams : Enters the command strings as shown below :
* DwsSize : Buffer length(Null value included)

Value Byte
‘D'C''S 3 Bytes
R’ 1 Byte
Optional Value ‘0/1’ 1 Byte

‘0" : Deletes all the calls located on the line.

‘1’ : Deletes the disconnected calls
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When the Device of the PBX is Initialized as Well

* hLine : Processes the lines to be used.

e dwAddressID : 0

e hCall : Not used

e |pParams : Enters the command strings as shown below :
* DwsSize : Buffer length(Null value included)

Value Byte
‘D''C''S 3 Bytes
X' 1 Byte
Optional Value : 1 Byte
‘0’ : Reads the information on the current line status.(Not used)
‘1’ : Initializes the current line status.
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CHAPTER 6

Call Processing Flow

This chapter describes the life cycle of the TAPI, the call processing events of the
OpenTSP driver, and call processing procedures.

1 Life Cycle of the TAPI

The knowledge of the TAPI life cycle shown below is needed to use the TAPI-based
application to process calls :

Cycles 1 to 3 shown in Figure 6.1 are described below :

Cycle 1

linelnitialize

!

LineGetDevCap

|

lineOpen

|

lineMakeCall

|

lineDrop

!

lineClose

|

lineShutdown

Figure 6.1

Life Cycle of the TAPI

The Phone Dialer and call center makes/connect/answers a call according to the steps
of Cycle 1 as shown in Figure 6.1 :
Each application can use the linelnitialize() function and then other TAPI functions.
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Also, the lineShutdown() function should be called to prevent the TAPI-compatible
application from using the TAPI function.

Each TAPI-compatible application can call the linelnitialize() function to check the
number of the devices available by the TAPI service and register the processing
modules for call processing events generated from each device. Also, the TAPI
service loads the unloaded Telephony Service Provider(TSP) on the TAPI service by
executing the linelnitialize() function to change each TSP driver to an operating state.
Different TAPI-compatible applications can simultaneously call the linelnitalize()
function. The information registered during each calling is automatically classified
and sorted by the TAPI service.

The lineShutdown() function is used when each TAPI-compatible application does
not use the TAPI functions any more. If this function is called, the TAPI service will
delete the information registered during the linelnitialize() process in order not to
report the call status events generated from each device.

Also, if the lineShutdown() function is called when any application does not use the
TAPI service, the TAPI service will upload all the loaded TSPs.

Cycle 2

Call the linelnitialize() function to find out the number of devices available in the
TAPI service of the system. Then, the TAPI-compatible application calls the
lineOpen() function to make necessary line devices available to each application.
The application, which has got permissions for the line after executing the lineOpen()
function, can receive information on call processing in each line device and use
functions on calls.

The TAPI-compatible application calls the lineClose() function when the application
disables the line devices. If the lineClose() function is called, the call processing events
generated from the line devices will not be reported and the functions for call
processing cannot be used for the line devices.

Cycle 3

The TAPI-compatible application that has permissions for each line device through
the lineOpen() function can use call processing functions for the line. Also, since the
TAPI-compatible application receives the call processing events for the status of all
calls, it can be defined to perform necessary operations according to the processing
rule of the application. The call processing functions are available only if call objects
exist in the line device.

How to Use Functions

For information about how to use the functions, refer to the Microsoft web sites about
NOTE the TAPI.
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Call Processing Events for the OpenTSP Driver

The TAPI service of the system offers the call processing events generated from the
line device to the application after calling the lineOpen() function so that the TAPI-
compatible application can use a specific line device as shown in the TAPI Life Cycle
2 of Figure 6.1.

This section describes the type of the call processing events to be reported while, the
call processing events are generated from the Samsung key telephone system and
forwarded to the TAPI service through the OpenTSP driver as well as processing
procedures.

Major Events

LINE_CALSTATE and LINE_CALLINFO are the events that all the TAPI-
compatible applications should process by default. These events are reported when
the status of a specific call and the details of each call are changed in each line device.

LINE_CALLSTATE

The LINE_CALSTATE event is reported when the status of calls is possibly changed
in each line device. Examples of the call status include IDLE, RINGBACK,
OFFERING, CONNECT, HOLD, and DISCONNECT. The call status is reported in
event of status transition. When the LINE_CALLSTATE event is generated, the
TAPI-compatible application calls the lineGetCallState() function to read the details
of call status.

LINE_CALLINFO

The LINE_CALLINFO event is reported when information on calls in each line
device is changed. Information on calls needed during call processing includes caller
ID/name, called party ID/name, the phone number/name of the person to whom a call
is forwarded, and call status. The information can be changed. When the information
is changed, the LINE_CALLINFO event is reported. The TAPI-compatible
application calls the lineGetCalllnfo() function to read the details when the
LINE_CALLINFO event is generated.
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Flow Chart of Call Status

When call status is changed, the OpenTSP driver reports information on call status
through the LINE_CALLSTATE and LINE_CALLINFO events. The
LINE_CALLSTATE event reports the information on the status change of the
generated calls and the LINE_CALLINFO event reports the information on the
details of each call are changed.

The figure below briefly shows the change of call status from call generation to

termination :
0 bLE J————
RINGBACK @

A

OFFERING

'

CONNECT

—

HOLD

Figure 6.2 Example of Flow Chart of Call Status
Outgoing and incoming calls are exemplified below :

When Making a Call from Extension 2001 to Extension 2002

The procedure for making a call from Extension 2001 is as follows :
* IDLE->DIALTONE->RINGBACK->CONNECTED->DISCONNECTED->
IDLE

The procedure for connecting a call with Extension 2002 is as follows :
* |IDLE->Offering>CONNECTED->DISCONNECT->IDLE

When call status is changed as described above, the OpenTSP driver forwards the
LINE_CALLSTATE event to the TAPI-compatible application through the TAPI service.
The TAPI-compatible application calls the lineGetCalllnfo() function to obtain the details
of call status.

© SAMSUNG Electronics Co., Ltd.



OfficeServ OpenTSP Driver Description/Ed.00

CHAPTER 6.

Call Processing Flow

2.3

Flow Chart of the Status of Calls in Progress

The events and messages generated while a call is being processed(i.e. from making a
call to connecting a call) by the TAPI-compatible application are as follows :

The figure below shows the example of events on call status sent to the TAPI-
compatible applications of both a caller and called party when a call is in progress :

Caller Side

TSP/Switch Side

Make Call to Destination

Called Side

Idle State

Dial Tone State

Ringback State

Connect State

Disconnect State

IDLE State

AR

“.Crate New Call

o Dial tone Event

Ringback Event

Crate
) New Call:,
Offering Event

Idle State

Connected Event

| ComeasdEven

Drop Event

Hook On Event
*.. Deallocate

iCurrent Call
»

Answer This Call
W

Drop This call

@‘

Deallocate
Current Call’.,.
Y

IR

Offering State

Connect State

Disconnect/idle
State

Figure 6.3 Flow Chart of the Status of Calls in Progress
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2.4 Details of Calls

When call status is changed like a call is made from Extension 201 to Extension 202
by using the TAPI Sampler program, the status message of call is displayed for each
occurred time. The messages of call status change include caller IDs, called IDs,
trunk numbers, DNIS information, call directions, and reasons for call generation.

As shown in the displayed screen below, the messages of call status show both the
status change of the call(LINE_CALLSTATE) and the change of the details of each
call(LINE_CALLINFO). Once the details of calls are changed, the details are
forwarded from the OpenTSP to the TAPI service through the LINE_CALLINFO
event. Also, the TAPI-compatible application calls the lineGetCallinfo() function to
read the changed information or one to be checked.

Caller (Extension 201)

Time [ Event |
09:24:29 201 opened,
09:24:54  LNECALLSTATE_DIALTCME received
09:24:55  LUMECALLSTATE_RINGBACK received
09:24:65  LINECALLIMFO on Ox000102ee received
09:24:86  LINECALLIMNFO: 0x0001022e
dwTotal Size=0:000001 23 dwMeededSize=0=00000154 dwllsedSize=0:00000154
hLine=0x00010356 dwlineDeviecelD=0x00000005 dwaddress|D=0:00000000
dw Trunk=0uwffffi-1)
CalledD=20z
Connected|D=202
09:24:57  LUMECALLSTATE_COMMECTED received
09:24:57  LINECALLIMFO on Ox000102ee received
09:24:57  UMECALLINFO: 0=000102ee
dwTaotal5ize=0:00000128 dwiNeedaedSize=0:00000154 dwlsedSize=0x00000154
hLine=0x00010355 dwlineDeviecelD=0x00000005 dwAddressID=0:00000000
dw Trunk=Dswfffi-1)
CalledID=20z
Canngctedii=202
O UREC ALCS TATE OIS CONNEC TED raceived
09:25:04  LIMECALLSTATE_IDLE received
09:25:04  IDLE Call Handle (0x000102ee) deallocated

Figure 6.4 Messages of Call Status

Called Party (Extension 202)

Time | Event |
09:24:36 202 opened,
09:24:55  LINECALLSTATE_QOFFERING received
09:24:65 LINECALLIMFO on 0=000102cc received
09:24:55  LINECALLINFO: 0x000102cc
dwTotalZize=0x000001a8 dwhleededSize=0=0000015c dwllsedSize=0=0000015c
hLine=0=00010311 dwlineDeviecelD=0=00000006 dwAddress|D=0x00000000
dwr Trunlk=0uxffifff-1)
CallerlD=201
CallediD=202
ConnectediD=201
09:24:57  LINECALLSTATE_CONMWECTED received
09:24:57 LINECALLIMFO on 0=000102cc received
D9:2dis? LINECALLINFO: 0x000102cc
dwTaotalSize=0:000001a8 dwheededsize=0=0000015c dwllsedSize=0=0000015:
hLine=0=00010311 dwLineDeviecelD=0x00000006 dwAddress|D=0x 00000000
e Trunk=0ufffff-1)
CallerlD=201
CallediD=202
ConnectedD=201
09:25:02  LINECALLSTATE_IDLE received
03:25:03 IDLE Call Handle (0=000102cc) deallocated

Figure 6.5 Messages of Call Status
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2.5 Holding Calls in Progress

If an extension asks for holding a call in progress, the TAPI-compatible applications
of both the caller and called party will receive the call status events as shown in the
figure below :

Caller Side TSP/Switch Side Called Side
Connect
— >
Connect State Hold Command Connect State
(Call 1) (Call 1)
.......................................................... »
Hold Event Connect State
(Call 1)

Dial tone Event

Timeout:,

Hold On State
(Call 1)
4

Dial tone State Hook On Event
(Call 2)
IDLE State
(Call 2)

Connect State
(Call 1)

Retrieve Command

Retrieved Event

.......................................................... >
Connect State
(Call 1)

Figure 6.6 Flow Chart of Calls on Hold

The status message created when a call in progress is held is displayed on the TAPI
Sampler program as shown below :

The Extension that has Asked for Holding a Call

Time | Event |
10:10:03  LINECALLSTATE_ONHOLD received

10:10:03  LINECALLSTATE_DIALTOME received

101005 LINECALLSTATE_IDLE received

10:10:05 IDLE Call Handle (0x000101ee) deallocated

101005 LINECALLSTATE_COMMECTED received

Figure 6.7 Messages of Call Status
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The Extension where a Call has been Held

Time | Event |
10:10:03  LINECALLSTATE_CONMECTED received
110:03 LINECALLIMNFO on 0=00010222 received
1e10:03 LINECALLIMFO: 0x000710222
dwTotal5ize=0x00000128 dwMeededSize=0x0000015c dwllsedSize=0=0000015c
hLine=0x00010311 dwlineDeviecelD=0x00000006 dwaddressID=0=00000000
dw Trunk=0x=ff -1}
CallerlD=201
CalledID=202
ConnectediD=201
110:05  LINECALLSTATE_COMMECTED received
1010:05  LINECALUIMNFO an 0x00010222 received
1m10:05  LINECALLIMFO: 0x000710222
dwTotalSize=0x00000128 dwhMeededSize=0x0000015c dwllsedsize=0:0000015c
hLine=0:00010311 dwlineDeviecelD=0x00000006 dwaddressID=0x00000000
dwTrunk=0x1iff(-1)
CallerlD=201
CalledID=202
ConnectedlD=201

Figure 6.8 Messages of Call Status
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CHAPTER 6. Call Processing Flow

2.6

Procedure for Consult Transfer

If either Extension 201 or Extension 202 forwards an extension call to another

extension(203) while Extension 201 or Extension 202 is making the call, the TAPI-
compatible applications of the caller, called party, and forwarded party will receive
the call status events as shown in the figure below :

Caller Side(201)

TSP/ Swi

tch Side Called Si

de(202)

Target Side(202)

Con

nect

Connect State
(Call 1)

Hold On State
(Call )

Dial tone State
(Call 2)

Ringback
State

Connect State
(Call 2)

Idle State
(Call 1)

Idle State
(Call 1)

i W

Transfer Command

\4

Held Event
Dial tone Even

ial to Destination

Offering Event

Connect State
(Call 1)

Connect State
(Call 1 with 201)

i

Create
New Call =
o

Idle State
(Call 1)

y/

\

Complete Transfer Command

/

<

Transfered Event

Completed Even

\

Offering State
(Call 1 with 201)

Connect State
(Call 1 with 201)

v

0H e

Connect State
(Call 1 with 203)

Figure 6.9 Flow Chart of Call Forwarding Status
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The call status messages for the consult transfer are displayed on the TAPI Sampler
program as shown below :

Extension 201

Tirme [ Event

10:69:41 LIMECALLSTATE _OMHOLDPEND TRAMSFER received on Ox00010289

10:69:41 LIMECALLSTATE _DIALTOME received on 0x000101ef

10:5%:44  LINECALLSTATE_RINGBACK received on 0x000101ef

10:52:44  LINECALLINFO on 0x000101ef received

10:5%:44  LINECALLINFO: 0=000101ef
dwTotalSize=0:000001a8 dwMNeededSize=0x00000154 dwlsedSize=0x00000154
hLine=0:00010044 dwlLineDeviecelD=0x0000000% dwaddress|D=0:00000000
dw Trunk=0x=f 1)
CalledlD=203
Connected D=203

10:5%:46  LINECALLSTATE_COMNMECTED received on 0:000101ef

10:52:46  LINECALLINFO on 0x000101ef received

10:5%:46  LINECALLIMNFO: 0=000101ef
dwTotalSize=0:000001a8 dwMeededSize=0x00000154 dwlsedSize=0x00000154
hLine=0:00010044 dwlLineDeviecelD=0x0000000% dwaddress|D=0:00000000
dw Trunk=0x=f 1)
CalledlD=203
Connected D=203

10:59:49  LINECALLSTATE_IDLE received on 0x000101ef

10:52:50  IDLE Call Handle (0x000101ef) deallocated

10:59:50  LINECALLSTATE_IDLE received on 0x00010289

10:59:50  IDLE Call Handle (0x00010289) deallocated

Figure 6.10 Call Status Messages for Consult Transfer of Extension 201

Extension 202

Tirme | Event |

10:59:41 LINECALLSTATE_COMMECTED received on 0x00010212
10:59:41 LINECALLIMFO on 0=00010212 received
10:59:41 LINECALLIMFO: 000010212
dwTotal5ize=0x000001a8 dwheededSize=0x0000015c dwl=sedSize=0x0000015c
RLine=0:00010033 dwlineDeviece|D=0x00000006 dwhAddressID=0:=00000000
dw Trunk=0x=fifffii-1)
CallerlD=201
CalledID=202
ConnectedD=201
10:59:43  LINECALLSTATE_COMMECTED received on Ox00010212
10:59:49  LINECALLIMFO on 0=00010212 received
10:69:49  LIMECALLIMFC: Dx00010212
dwTotal5ize=0x000001a8 dwieededSize=0x0000016c dwll=sedSize=0x:0000016c
hLine=0x00010033 dwlLineDeviecelD=0=00000006 dwAddressID=0=00000000
dw Trunk=0x=fifffii-1)
CallerlD=201
CalledID=202
ConnectedlD=203
Redirection|D=203
RedirectinglD=201

Figure 6.11 Call Status Messages for Consult Transfer of Extension 202
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Extension 203

Time | Event
106344 LINECALLSTATE_OFFERING received on 0x00010234
1006944 LINECALLIMFO on 000010234 received
1005344 LINECALLINFO: 0=00010234
dw TotalSize=0x00000128 dwhMeededSize=0x0000015c dwlsedSize=0x0000015c
hLine=0:00010278 dwLineDeviecelD=0x00000007 dwAddressID=0:00000000
dw Trunk=0xftff - 1)
CallerlD=201
CalledID=203
Connected/D=201
10:69:46 LINECALLSTATE_CONMECTED received on 0=00010234
105346 LINECALLIMFO on 0=<00010234 received
10:69:46  LINECASLLINFD: 0=00010234
dwTotalSize=0x000001a8 dwNeededSize=0x0000015c dwlsedSize=0:0000015c
hLine=0=00010278 dwLineDeviece!D=0x00000007 dwaAddressID=0:00000000
dw Trunk=0xfiffif-1)
CallerlD=201
CalledID=203
Connected|D=201
10:53:43  LINECALLIMFO on 000010234 received
10:69:49  LINECALLINFD: 0=00010234
dwTotalSize=0x000001a8 dwhNeededSize=0x0000016c dwlsedSize=0:0000016c
hLine=0=00010278 dwLineDeviece!D=0x00000007 dwaAddressID=0:00000000
dw Trunk=0xfiffif-1)
CallerlD=202
CalledID=203
ConnectedD=202
Redirection|D=203
RedirectinglD=201
Figure 6.12 Call Status Messages for Consult Transfer of Extension 203
Type of Call Processing Messages in the TAPI Sampler Program
The messages of call progress such as Blind Transfer, Conference, PickUp, and
NOTE Redirect can be checked from the TAPI Sampler program.
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ABBREVIATION

API

ASP
C

CD

CTl
D

DCS

DND

DNIS

DTMF
H

HTTP
|

ID

iDCS

IP
0]

OHVA
P

PIDs
R

ROM

Application Program Interface
Abstract Service Primitive

Compact Disk
Computer Telephony Interface

Digital Cellular System
Do Not Disturb

Dialed Number Identification Service

Dual Tone Multi-Frequency

Hypertext Transfer Protocol

Identification
internet Digital Cellular System
Internet Protocol

Off-hook Voice Announce

Process Identifications

Read Only Memory
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T

TAPI Telephony Application Programming Interface
TCP Transmission Control Protocol

TSP Telephony Service Provider

TSPI Telephony Service Provider Interface
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